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INTRODUCTION

The purpose of this chapter is to introduce you to the use of illustrations and headings
in business report writing. While the quality of your writing itself remains the para-
mount concern—both for grading in this course and for success in your professional
life after college—tables, graphs, charts and other visuals such as headings also play
important “supporting roles” in the creation of effective and attractive reports that
appeal to the audience’s eyes and help you get your points across clearly.

Objectives

This chapter will culminate in your production of four illustrations typically used in
business reports, a table, bar graph, pie chart, and line graph. You will support each
illustration with a consistently formatted title and source line. Finally, you will learn to
effectively integrate illustrations within the text. After completing this chapter’s assign-
ment you will be able to:

. Use computer software such as Word or Excel to design accurate, attractive,
easy-to-read tables and figures that report statistical data on your business
topic;

* Integrate and discuss these visuals within the text they illustrate;

¢ Label and document your illustrations with consistently formatted titles and
source lines.

Additionally, this chapter will help you use headings to organize your business reports.
You will learn the strategy behind hierarchical headings, see examples, and use MS
Word styles for attractive, consistent headings that enable you to create a table of
contents at the click of a mouse.
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28 Business Writing

DESIGNING AND INTEGRATING
SIMPLE ILLUSTRATIONS

Because graphics play an integral part in business communication, you
are not alone in your quest to become “computer graphics literate”. You
may use some creativity as you customize your illustrations for your
purposes and audience; however, the success or failure of your intended
message depends on your audience’s understanding and reactions. A few
“universal” ground rules can prevent confusion.

Tables and Figures: Important Distinctions

In traditional business usage, illustrations fall into two categories. Each
illustration should be labeled as either a table or figure. What is the
distinction between a table and a figure? According to The Business
Writer’s Companion, tables “can present data, such as statistics, more
concisely than text and more accurately than a graph.”! Thus, when you
wish your reader to pay close attention to numbers—dollars or pennies,
percentages or percentiles, pounds or populations—and to recall them
exactly, a table is your better choice for displaying your information and
for communicating your message clearly and precisely.

Tables align data in cells for vertical comparison in columns or horizon-
tal comparison in rows. Grid lines can help your audience gain accurate
understanding at a glance when the data is complex or closely spaced, or
if the eye may have trouble following the correct row or column.

However, if your purpose is to show your audience some type of relation-
ship among your data, a figure may be the way to go. Again, the Business

Suggested Reading

To get the most out of this chapter, you should first read Chapter 2, “Words, Images,
and Graphics”, and “Chapters 11 and 12, “Design Basics” and “Illustrations, Tables,
and Charts” in The Penguin Handbook. Annotate as you read, noting your responses,
comments, and questions in the margins. Then, as you review, pay closer attention
to the types of graphs or charts used for different kinds of data. Also notice the
spacing, colors for contrast and clarity, and fonts. Compare these with the sample
illustrations in this chapter and at the back of this book.

In The Penguin Handbook you will also find a useful summary of heading strategies
(205-208). For examples of some variations found in heading formats, see the
samples in The Penguin Handbook (figure 11.4) and in Appendix B in the back of this
book.

!Gerald J. Alred, Charles T. Brusaw, and Walter E. Oliu, The Business Writer’s
Companion, 3rd ed. (Boston: Bedford/St. Martin’s Press, 2002), 203.
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Writer’s Companion clarifies the distinction between tables and figures:
“Trends, movements, distributions, comparisons, and cycles are more
readily apparent in graphs [one member of the figure family] than they
are in tables. However, although graphs present data in a more compre-
hensible form than tables, they are less precise. For that reason, graphs
are often accompanied by tables that give exact data.”?

Throughout English 203, your text will introduce and label all illustra-
tions as either tables or figures. Following your formal introduction and
labeling of your illustration, your discussion of its meaning can call your
figure a graph, chart, diagram, photograph, picture, map, histogram,
Gantt chart, cutaway, etc., as appropriate. Just make certain your initial
introduction and label use the term “table” or “figure” and that any
subsequent term will not confuse your reader.

THE BASICS OF ILLUSTRATION DESIGN

Here are some accepted traditions and requirements to keep in mind as
you design and integrate your illustrations.

e Ask yourself if an illustration helps communicate a specific,
important and relevant point. Avoid “fluff” illustrations that
just pad out or decorate your report. Only illustrate data or
ideas that contribute significantly to your report’s purpose.

¢  Follow the IDD—Introduce, Display and Discuss—organiza-
tional plan for integrating text and illustration.’

*  Assign every illustration a label —Table or Figure —and an
Arabic numeral (e.g., Table 1). Number tables and figures
separately (a report with both tables and figures will have a
Table 1 as well as a Figure 1, and so on).

e  Compose a concise, precisely descriptive label that captures the
visual’s main point. (e.g., Leading Sires of 2006 by Progeny
Earnings, not something vague like Leading Sires).

¢ Document the source of your data in a source line appearing
beneath the illustration. Using the word Source, followed by a
colon, is a common practice. Source lines should never contain
URLs (web addresses); confine these to notes and the Bibliogra-
phy (CMS), Works Cited (MLA), or References (APA) page.

*  Make sure label, source line and other typeface format is consis-
tent for all illustrations throughout the report.

¢ In tables use row and column headings to organize your data; in
graphs and charts use axis labels, along with legends or data
labels (callouts), to help clarify the data at a glance.

2 Ibid., 189.

3 Shirley Kuiper and Gary F. Kohut, Contemporary Business Report Writing, 2nd ed.
(n.p.: South-Western College Publishing, 1999), 89-90.
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*  Use contrasting colors to help your audience see foreground
bars, pie slices, etc., against the background and to help them
easily distinguish between data series.

*  Place your illustrations in a balanced position on the page, and
do not allow labels or source lines to fall on a different page
from their illustration.

¢  Finally, always ask yourself if your illustration is clear, attractive
and businesslike in appearance, and —of course—free of typos
or other errors.

One of the best habits you can develop is to allow yourself time to create
and tweak your illustrations, since they can present software problems
that may take time to solve, and since an illustration that seems perfect
on the screen may show problems when printed. Another is to ask a
reliable friend to interpret your illustration and respond to its appearance.
The data must be clear not only to you, but to an audience who does not
share your understanding of the material.

Designing Tables

Tables employ a simple scaffold: horizontal rows present one category of
information; vertical columns present another. We refer to the list of row
labels along the left side of a table as the stub. The top of a table is called
the boxhead, or column labels.

Tables may feature gridlines, or they may have only white space separat-
ing the cells of information. For tables that present plentiful information,
gridlines may be needed for quick, clear understanding. Shading in
alternating rows or columns can also promote easier reading. Software
programs offer many bells and whistles to make tables more attractive
and highlight specified data in the table, but simply formatted tables
never go out of style, and even the software-challenged novice can create
them.

Take a look at Table 3-1 on the next page. This table illustrates numerical
data showing a simple breakdown of the the top five budget MP3 players
on the market today. Also examine the table’s parts, labeled in italics with
arrows.

To create a table in Microsoft Word, click the Insert Table button on the
standard toolbar, then drag to choose the desired number of rows and
columns. Or, on the Table menu you can choose Insert, Table, and set the
number of rows and columns in the dialog box. If you wish, you can add
eye-catching format to your table, either by choosing Table AutoFormat
on the Table menu, or manually by clicking the Format menu and choos-
ing Borders and Shading. As you format, keep in mind that attractive-
ness is not the only criterion for tables in reports and presentations; it is
essential to present the data clearly and guide the eye along the rows or
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The label includes the table number and title.

“ bovhead helps dltingush
Table 3-1. Top 5 Budget MP3 Players. it from the data cells,
Brand Storage Capacity Suggested Retail Price
Apple iPod nano 2GB $129.00
Create Zen MicroPhoto _| 4GB 127.60
SanDisk Sansa €250 2GB 126.00
iriver elix 2GB 1796 -
Apple iPod shuffle 1GB 67.00

Source: Nino Marchetti * Source line. Note that the source line for this table ends with
\ a Chicago (CMS) style footnote or endnote number. If you are
using MLA or APA documentation style, your end reference
should be parenthetical.

columns. Distinguishing the boxhead or stub from the data cells also
enhances comprehension.

After you have created and formatted your table, use this checklist to
ensure it includes:

e  Alabel (e.g., Table 3-1. Top 5 Budget MP3 Players.)

. A boxhead, stub, or both, with clear, descriptive column/row
headings

* A source line identifying where you got the data, ending with a
superscripted note number (CMS) or parenthetical reference
(MLA or APA). A web address should never appear in a source
line.

Designing Figures

Graphs and charts enable readers to compare quantitative data visually, to
detect patterns, to understand relationships and proportions, to trace
changes over time or distance, to ascertain differences among groups, to
comprehend the frequency of an occurrence, or to predict growth and
decline. On the other hand, photographs and diagrams enable readers to
identify objects, to understand spatial relationships, and to gain qualita-
tive impressions of their subjects.

Like tables, figures can be simple or complex. But again, adherence to a
few formal requirements, along with practice with your software, will
result in complete and accurate illustrations that work with your text to
get your information and message across to your audience.

* Nino Marchetti, “Top 8 Budget MP3 Players,” http://portables.about.com/od/
mp3players/tp/budmp3play.htm.
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Bar Graphs

Bar graphs enable us to compare quantities by time, location or category.
For example, the visual impact of Figure 3-1 might alert Writing Center
administrators that tutors need training not only for helping first year
students, but graduate students (this result might be unexpected, and in
turn points out the next need: to identify what sort of help graduate
students seek and train tutors to provide that help), Our simple bar graph
compares ten variables (client categories). However, bar graphs are
especially valuable for their ability to compare multiple data series. For
example, ten client categories could be compared for three different
semesters by clustering three bars in three colors (three semesters) for
each client category. For a good example of a bar chart comparing mul-
tiple data series, see page 226 of the Penguin Handbook.

Label. Note that figures are numbered separately from tables.

Figure 3-1. The University of Kentucky Writing Center client base.
Spring 2003 mid-term numbers and classifications.

Y-axis label (also called "value axis” in Excel)
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Client Groups

Source: Created from data compiled by Judy Gatton Prats, University of Kentucky
Writing Center, spring 2003.

Bar graphs can also have horizontal, segmented, or bilateral bars. For
examples of the ways these designs are used, check out the latest issue of
your favorite business or money magazine, or study the first-rate visuals
from any issue of Consumer Reports, considered by many graphics special-
ists as the “granddaddy” of informative, straightforward, and immensely
useful illustration theory and design.

While bar graphs can compare amounts over time, sometimes it is the
changes, the trends over time, that we want to emphasize in order to
predict future trends. In that case, a line graph is the best choice.
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Line Graphs

Line graphs show continuous sequences, usually trends through time. A
line graph should not be used to compare non-sequential data (for that,
use a bar graph). For our line graph, we will continue practicing with
University of Kentucky Writing Center data, but since out last data was
non-sequential, for our line graph we will display different data. The
number of clients per semester over a four-an-one-half hear period is
sequential data. The simple line graph below shows a single data series:
numbers of clients (quantitative variable) as they increase or decrease
over nine semesters (time variable). Since its inception in 1983, the
Writing Center has grown in facilities, staff, and client demand. Figure 3-
2 below depicts the growth in client demand for the academic years
1998-2003.

Figure 3-2. University of Kentucky Writing Center client numbers. Fall
and spring semesters, 1998 through spring 2003.
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Source: Created from data supplied by Judy Gatton Prats, University of Kentucky
Writing Center, 29 July 2003.

The line graph above illustrates enough information to suggest an overall
trend in Writing Center numbers: they are, with the exception of one
semester, moving steadily upward. Identifying this trend might help
Writing Center administrators decide how many tutors to hire for the
coming semester. Additionally, focusing on “oddball” variables (such as
the drop in Spring 2002) might help administrators solve current prob-
lems (what caused the recovery in Fall 2002, and might that event suggest
ways to boost client numbers next semester?). An even closer examina-
tion of Figure 3-2 reveals a further pattern that may prove important: fall
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semester usage numbers tend to be higher than spring overall. We can
then begin to interpret the trend: nervous first semester students may
tend to use the Writing Center with decreasing frequency as they gain
confidence in their second semester, or Greeks and other organizations
may pressure new initiates to keep up grades, or we may need to research
further to understand what is actually going on.

Figures 3-1 and 3-2 illustrate the required parts of a graph:

* A label, beginning with “Figure” followed by its number in the
sequence of your figures, then a concise, descriptive title;

*  An adequately titled x-axis (Excel calls it the category axis), also
known as the independent variable axis or horizontal axis. This
axis is also referred to as the time axis because this axis is usually
the one depicting months, quarters, years, and so on. For their
monthly reports to stockholders, stockbrokers depend on this
axis to reveal a stock’s growth or decline over a certain number
of days. Categories can also be represented along the x-axis, as
in our Figure 3-1, where the x-axis is labeled Client Groups
[revise if nec.]. Along the x-axis we can also insert labels for
further identification of individual series;

*  An adequately titled y-axis (Excel calls it the value axis), also
known as the quantitative axis, and the dependent variable axis
or vertical axis. The y-axis usually shows the units of measure;

*  Data series labels. These afford more precision to back up our
pictorial impression, informing the audience of exact numbers.
Ask your instructor if he or she will always require data series
labels. Get an opinion from your peer reviewer also. If labels
create clutter by duplicating information, it is wise to leave
them off;

. A source line; figure source lines follow the same rules as table
source lines.

Optionally, a graph may also include a legend, or color key, a box within
the illustration (usually to the right of the graph itself), identifying data
series by color or pattern. However, if the series are already distinguished
in the x-axis, a legend that only repeats this information is unnecessary.

Bar and line graphs compare and track separate quantities or events.
When we want to compare percentages within a whole, the way to go is a
pie chart.

Pie Charts

Although we could translate our Writing Center client profile data into a
pie chart, the point is not just to make charts and graphs, but to illustrate
data effectively to communicate ideas. Since our focus is on bringing
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more clients to the Writing Center, a meaningful question at this point is
how people find out about the Writing Center. With a pie chart we can
illustrate which methods of publicity attract the highest percentage of
clients.

A pie chart is a circle divided into pie slice-shaped wedges. The circle or
whole pie represents the whole amount of whatever we are discussing;
each wedge represents a proportion of the whole. Thus, the percentages
expressed on a pie chart must add up to 100%. When we want to empha-
size relative percentages, rather than exact numbers or trends, pie chart-
ing does the job. Figure 3-3 below illustrates which publicity methods
have brought in the highest percentages of Writing Center clients. In this
case, 100% is all Writing Center clients.

Figure 3-3. The University of Kentucky Writing Center publicity. How
clients learned about the Writing Center. Spring 2003 mid-term
numbers.

Other Sources /K_—‘
27% Classroom Teachers
52%
[ 339 /

A 648

Information ¢
Flyer —
5%
Summer
Orientation —
8%
Advisor

Source: Adapted from Judy Gatton Prats, University of Kentucky Writing Center,
Spring 2003.

Clearly, we can see from the pie chart above that more than half of all
Writing Center clients learned about the Center’s services from their
teachers, but our interpretations of the chart may vary. Maybe teachers’
encouragement is the best recruiting method and more teachers should
encourage their students to try the Writing Center. However, another
possible interpretation is that teachers are already informing their stu-
dents about the Writing Center and we need to devise additional encour-
agements. To assess which interpretations are correct, we need to find out
more. Often, we cannot expect a report illustration to answer a question;
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instead it can help point out what else we need to learn before the ques-
tion can be answered.

As with a graph, a pie chart should include a figure label and source line,
and it should follow the same conventions for legibility and consistent
format. Additional pie chart rules include the following.

A pie chart should always break 100% of a whole into percent-
ages to compare parts of a whole (e.g., of all people supporting
government-funded medical care, what percent are under 30
years old, what percent are 30 to 60 years old, and what percent
are over 60 years old?).

Each pie chart should illustrate only one data series (e.g., all
people supporting government-funded medical care). Two data
series can not be compared in a single pie chart (e.g., opposers
of government-funded medical care broken down by age can
not be shown in the same pie); the result might look like a pie
chart, but an attempt to interpret it would soon discover it had
no meaning. To compare percentages of age groups supporting
with percentages of age groups opposing, we need two pie
charts placed near each other on the page.

Keep the number of pie wedges manageable; twelve is the
maximum number of wedges for a readable pie.

Balance circle segments. Since most Westerners read left to
right, and clock faces also move our eyes to the right, accommo-
date your audience’s visual bias by placing the most important
segment at the twelve o’clock position and opening it clockwise.
Place your other segments around the pie in descending order
of size unless you have a good reason for grouping them in
some other way.

Avoid distorting the data with 3-dimensional effects. The tilted
perspective of a 3-D pie charts can give a misleading impression
(also, when viewing others’ 3-D pies, check the numerical labels
to make sure your impressions are correct). If a 3-D pie is
needed for a consistent look, tilt the perspective only slightly (In
MS Word, you can control the angle by right-clicking the
selected pie chart and choosing 3-D View). The more the tilt,
the more misleading the impression.

Always supply numerical labels for each wedge’s percentage,
preferably on the wedges themselves or in callouts (numerical
labels sometimes occur in the legend only, but this method is
not as clear at a glance).

Other lllustrations

Photographs, diagrams, flow charts, time lines and other visuals should
also be presented as figures and given numbers in the figure sequence
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(tables are the only illustrations not treated as figures). Provide a source
line, as for all figures. When deciding whether to include a photograph
or other picture, apply the same rules that you would for graphs and

charts:

Does the picture communicate a message? Pictures should
never just decorate reports; they should always contribute
significantly to your purpose.

Are the important elements of the picture clearly visible? Of-
ten, photographs lose definition through pasting or printing, so
be sure that pictures in your report print with clear focus and
color contrast, and without distortion.

Specific guidelines for illustrating with pictures can be found in chapters
2 and 12 of the Penguin Handbook.

Integrating lllustrations and Text

Once you have created your illustrations, you must integrate them with
your words, or text. Follow the IDD organizational plan:

Introduce the table or figure by referring to it by its proper
name of Table 1, Figure 1, and so on, and by summing up its
contents in a thesis-like sentence or two.

Display your illustration (insert it into the text).

Discuss what your illustration shows about the data, particu-
larly what is interesting or strange or unexpected. Why did you
include this illustration? The answer to that question can help
you frame your explanations and discussion for your audience’s
benefit. In other words, the final, necessary move you must
make is to interpret the meaning of your illustration; do not
expect your audience to perform this work for you. You must
make sure they follow the idea you are illustrating and why that
idea is important to your purpose.

Ethics and lllustrations

A final criterion we should all think about as we design and integrate
illustrations is that of ethics. Although most of us would not intentionally
use visuals to mislead audiences, we might unconsciously do so through
carelessness or laziness. Therefore, we must pay careful attention to scale
and proportion.

If a graph is distorted, important anomalies may disappear or
flatten out. For instance, unevenly divided, compressed or
expanded numerical increments on the y-axis can distort bar
and line graph information, making the significant seem insig-
nificant, or vice versa.
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*  3-dimensional pie charts tilt the circle, making the near wedges
look bigger than they are and the far wedges look smaller. The
more tilted the pie, the more the distortion.

¢  The numerical data used to create the illustration should always
be included in clearly legible print on a graph or chart, and
always double-checked for accuracy. Unless you generated the
data yourself (in a survey you conducted, for example), it
should always be credited in a source line with a reference, even
if the source is also referred to in the text.

Final Words about Successful lllustrations

You can assist your audience’s comprehension by making your illustra-
tions simple and attractive. An illustration should communicate at a
glance. Keys to attractive, orderly illustrations are contrast and balance,
consistent format for all illustration’s color schemes, type faces and place-
ment in relation to the text, and freedom from GSPs and printing botches
(beware—your spell checker may not catch typos within illustrations, but
illustrations stand out on the page, making errors in them are especially
embarrassing) Last but not least, following ethical practices with your
illustrations, as with your text, helps your audience draw accurate conclu-
sions and make valid decisions. Ethical practices are also pragmatic, since
they demonstrate to your audience that you are a responsible and trust-
worthy professional.

REPORT HEADINGS

Organizing a business report involves some strategies familiar from your
previous college writing. Once you have determined your purpose and
collected your research, you should organize for a logical progression of
ideas, using accepted conventions such as an introduction, body, conclu-
sions, and source documentation. However, business reports include
other conventions that are probably new to you—as a writer. As a reader,
you have seen some of them, especially hierarchical headings that guide a
reader through a progression of ideas and help the reader locate informa-
tion in the report. The benefits of using headings effectively in business
reports include your audience’s better understanding of your message,
and the likelihood that your audience will treat your ideas more seriously
if they are organized and formatted according to professional conven-
tions.

HEADING STRATEGY

Business reports are organized with hierarchic headings. “Hierarchic”
may sound daunting, but it is a simple way to think about your headings
that eliminates confusion about what kinds of headings to use and where
to use them. Compare your headings with the hierarchy, or “pecking
order,” organizing people in a corporation. If you compare a report’s title
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Figure 3-4. Practical examples.
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Use your textbooks themselves as examples of organizing with headings. The head-
ings subdividing the chapters into parts in Business Writing and The Penguin Hand-
book are closely akin to those used in business reports. The colors in the Penguin
Handbook headings are not usual in workplace reports, but note how big or bold
headings divide major sections, and less important-looking headings subdivide parts
within those sections. How do these headings help you follow, remember, and
relocate the material in both textbooks? Would this be as easy to do if each chapter’s
material were presented in long unbroken blocks of text?

with a company’s president or CEQ, the hierarchy descends from there:
at the first level stand a few vice presidents. Each vice president controls a
separate division of the company. Beneath each is a second level of depart-
mental directors who define the purposes and methods of the various
departments. In turn, each department contains third level managers,
each of whom supervise a staff. Business report headings are organized
in exactly the same way.

This strategy has evolved in response to the ways businesspeople read,
and respond to, reports. Many workplace environments present distrac-
tions and demand multitasking; therefore, organizing your report with
hierarchic headings helps keep your audience on track by facilitating
their understanding of your purpose and the progression of your ideas
and evidence. Since business reports are not only read, but also dis-
cussed in meetings and implemented, frequent headings also help your
audience quickly locate the exact information they need.

After the title, which appears on a title page, business report sections are
organized by headings as follows.

Level 1 Headings

Level 1 headings signal the major sections of the report. Most simple
reports have three level 1 headings: an introduction heading, a conclu-
sions heading, and between them a heading for the body of the report.
However, complex reports have more level 1 headings. For instance, the
body of a proposal or feasibility study may divide naturally into two
major (level 1 heading) sections: one for the problem and one for the
recommendations. A very formal report includes additional “front
matter” with level 1 headings, such as an executive summary, appendix,
etc. (to learn what front matter your report needs, refer to chapter 3 in
this book and your instructor’s directions). All level 1 sections should be
equal in rank (like vice presidents of a company); no level 1 heading
should signal a subsection of another section.

Therefore, level 1 headings might be “Lexington’s Water Controversy”
and “Recommendations for Water Management,” two separate sections
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explaining a problem and proposing a solution. Level 1 headings should
not be “Lexington’s Water Controversy and “The Case for Local Owner-
ship.” This second organization is incorrect because the case for local
ownership is one side of the water controversy; therefore it is a subcat-
egory within the water controversy section—a level 2 heading).

Level 2 Headings

Level 2 headings provide a valuable tool for dividing major sections into
their component ideas. Generally, business reports should include level 2
headings. Level 2 headings define subsections within a major (level 1)
section. So, a major section headed “Lexington’s Water Controversy”
(level 1) should describe the issues and establish that two contending
positions exist. Then, still within this major section, two subsections
(each with a level 2 heading) can explain the two sides in the controversy.
For example, within the “Lexington’s Water Controversy” (level 1) major
section might come a subsection headed “The Case for Local Water
Ownership” (level 2), then another headed “The Rationale for Corporate
Water Ownership” (also level 2). Each level 2 section is parallel to the
other; both are part of the level 1 topic.

Level 3 Headings

Level 3 headings signal further subcategories within a level 2 section.
Level 3 headings provide a valuable tool for breaking up a long level 2
section into easily digested pieces. Level 3 headings provide additional
nuts and bolts to establish relationships between your ideas. Most long
reports incorporate level 3 headings.

Level 4 Headings

Business reports often have no level 4 headings; however, if level 4 head-
ings will help organize your material, you may use them in reports of any
length. Level 4 headings signal further subcategories within a level 3
section.

Some additional general considerations for headings follow.

¢ No heading should directly follow another heading. Text
should always follow a heading of any level. If you have a level
1 heading, describe the issue covered in the section before
presenting the subsections.

*  Another consideration in using business report headings is
parallelism. Although you can add interest to your report by
injecting variety into the phrasing of your headings, clarify and
emphasize your report’s organization by making your headings
harmonize in grammar, style and structure (for example, you
might use descriptive fragments for first level headings, ques-
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Figure 3-5. Sample document using 4 levels of heading.

LEVEL 1 HEADING

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed~diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim-ad minim veniam, quis
nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip ex ea com
Duis autem vel eum iriure dolor in hendrerit in vulputate velit esse molestie conseq
illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio dignissim qui
blandit praesent luptatum zzril delenit augue duis dolore te feugait nulla facilisi. Lorem
ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh eui
ut laoreet dolore magna aliquam erat volutpat. Ut WISI enim ad mi eniam, quis nostrud
exerci tation ullamcorper suscipit lobortis nisl ut ali X ea commodo consequat.

Level 2 Heading
Duis autem vel eum iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel
illum dolore eu feugiat nulla facilisis at vero eros et accumsan et iusto odio dignissim qui
blandit praesent luptatum zzril delenit augue duis dolore te feugait nulla facilisi. Nam liber
tempor cum soluta nobis eleifend option congue nihil imperdiet doming id quod mazim
placerat facer possim assum.

Level 3 Heading

Lorem ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod
tincidunt ut laoreet dolore magna aliquam erat volutpat. Ut wisi enim ad minim veniam, quis
nostrud exerci tation ullamcorper suscipit lobortis nisl ut aliquip ex ea commodo consequat.
Duis autem vel eum iriure dolor in hendrerit in vulputate velit esse molestie consequat, vel
illum dolore eu feugiat nulla facilisis at vero eros et accumsarretiusto odio d|gn|SS|m qui
blandit praesent luptatum zzril delenit augue duis dolore te feugait nulla fai
ipsum dolor sit amet, consectetuer adipiscing elit, sed diam nonummy nibh euismod tinct
ut laoreet dolore magna aliquam erat volutpat.

Level 4 Heading. Ut wisi enim ad minim veniam, quis nostrud exerci tation ullamcorper
suscipit lobortis nisl ut aliquip ex ea commodo consequat. Duis autem vel eum iriure dolor in
hendrerit in vulputate velit esse molestie consequat, vel illum dolore eu feugiat nulla facilisis
at vero eros et accumsan et iusto odio dignissim qui blandit praesent luptatum zzril delenit
augue duis dolore te feugait nulla facilisi.

tions for second level headings, and dependent clauses for your

third level headings).

. Parallelism also covers the balance that should exist within a

section. Any section that contains a subsection needs to contain
at least two parallel subsections (e.g., if a level 2 section contains

any level 3 subsections, it should contain at least two). In this
way, report organization conventions resemble formal outline
conventions.

HEADING FORMAT

The sample headings above demonstrate a standard way of formatting
level 1, 2, 3 and 4 headings. This format’s popularity derives from MS
Word'’s default heading styles. Other heading formats can look just as

professional, but using Word’s heading styles has two advantages. First, it
makes consistency easy; second and more importantly if your report has

a table of contents, applying Word’s heading styles enables you to auto-

Sans serif
typefaces such as
Arial and
Helvetica work
well for headings
because they stay
crisp and clear at
large sizes.

Serif typefaces
such as Times New
Roman and
Garamond work
best in the body of
the report because
they are easy to
read in long
stretches of text.
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matically (and easily!) create a table of contents to professional specifica-
tions, as will be explained below.

Whatever formats you use for your headings, observe these rules-of-
thumb.

e  For emphasis, headings can employ a different font from the
report text, but their font should be businesslike (not flowery,
playful or script). Ariel and Times Roman are always reliable
fonts for a business report. Too many fonts will clutter a page,
so stick with two fonts at most, your text font, and your head-
ing font. (As in the level 4 heading example above, headings
within the paragraph should be in the same font as the text.)

*  You may choose font sizes that catch the eye and help break up
the page, but avoid typeface larger than 18 point in a business
report. In the examples above, the level 1 heading is 16 point.
The level 2 heading is smaller at 14 point, and the level 3 head-
ing is still smaller at 13 point. The text of the report should be
10 to 12 point. Notice that the sizes are graduated to emphasize
the hierarchy; the level 1 heading looks more important than
the level 2 heading, and so on. Headings within the paragraph
(as is our level 4 heading) should be the same size as the para-
graph text.

*  Boldface and italics also adds interest to headings. As with the
size, boldface can establish the importance of a heading, helping
your audience distinguish the major sections from the subsec-
tions so they can understand relationships between the report
sections.

Using Heading Styles to Build a Table of Contents

As mentioned above, using Word’s pre-defined heading styles not only
provides consistent, businesslike heading formatting, it allows you to
create a table of contents with a few mouse clicks. To apply Word'’s
heading styles, follow these instructions.

1. Type your heading, then press enter. Select the heading.

2. Click the dropdown arrow on the Style box. You will find the
Style box on the toolbar (by default, it says “Normal”).

3. When the dropdown menu appears, choose “Heading 1” for a
level 1 heading, “Heading 2” for a level 2 headings, etc.

If you wish, you can then modify the appearance of your heading manu-
ally by changing the size, adding or subtracting boldface, and so on.
Whatever the appearance, so long as the Style box shows that the correct
style is applied, Word can work its table of contents magic.

To generate an automatic table of contents, follow these steps.
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1. Make sure every heading carries the heading style correspond-
ing to its level (to see what style is applied, click on the heading
and check the Style box on the toolbar; it should say Heading 1,
or Heading 2, and so on).

2. Place the cursor where you want to insert the table of contents
(click to place the cursor, causing the cursor to blink).

3. From the Insert menu, choose Index and Tables. When the
Index and Tables dialog displays, click the Table of Contents
tab. Then click OK.

4. A table of contents will appear in your document. If you have
accidentally placed it somewhere you did not intend to, choose
Undo on the Edit menu, place the cursor correctly, and repeat
steps 1-3.

Note: If your table of contents does not appear or contains errors, choose
Undo on the Edit menu, then make sure the appropriate heading style is
applied to each heading, and that no heading styles are applied to any of
the regular report text.

Updating the Table of Contents

Revising your report may change your page numbering or headings,
necessitating changes in your table of contents. To update your auto-
matic table of contents:

1. Right-click on the table of contents. When the shortcut menu
appears, choose Update Field.

2. In the dialog that appears, choose Update Entire Table. Your
table of contents should now match your revised pagination
and headings.

Headings in Other Media

This chapter’s strategies for organizing with headings apply to report
headings in all media. Whether your report takes the form of a web
page, flyer or oral presentation, its headings should emphasize the organi-
zation of your report and the relationships between its parts. Their
phrasing should be descriptive and concise (Synthetic Race Track Sur-
faces Reduce Fatalities, not Synthetic Tracks).

However, these guidelines for formatting apply to print reports of a
formal or semi-formal nature. If you are formatting a report for a web
site, a flyer, or a presentation with visuals, you have more latitude with
heading fonts and colors. Chapters 2 and 11 of The Penguin Handbook
provide a basic introduction to display design for online and color media.
Whatever your medium, it remains a good idea to avoid the clutter of too
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many fonts or too many colors, and to stick with fairly conservative fonts
and colors unless your profession follows a different standard. In any
case, be sure all fonts and colors remain clearly legible.

Exercises for Chapter 3

Exercise 3.1. Using a word processing program such as MS Word and
the data provided below, create clearly, attractively formatted illustrations
of the type indicated. Be sure that each of your illustrations has a figure
number, descriptive title and source line.

A. Table.
This is the one-way travel itinerary for Ms. Carrie Adams,
District Sales Manager, Emerald City Enterprises:

*  Delta flight 393 leaves Cincinnati at 10:25 am on Octo-
ber 22 and arrives in New York at 2:02 pm.

¢ United Airlines flight 1462 leaves New York at 4:34 pm
on October 22 and arrives in London at 5:47 am on
October 23.

*  British Midlands flight 608 leaves London at 7:30 am on
October 23 and arrives in Paris at 9:32 am on October
23.

(Source: Delta Airlines, www.delta.com)

B. Bar Graph.
Four kinds of pizza were sold last summer at Rieti’s. The quanti-
ties, broken down by month, are:

*  June - 384 shrimp, 526 pepperoni, 473 mushroom, 201
anchovy

e July - 396 shrimp, 458 pepperoni, 502 mushroom, 209
anchovy

*  August - 389 shrimp, 386 pepperoni, 515 mushroom,
198 anchovy

(Source: interview with Angelo Rieti, Oct. 31, 2004)

Exercise 3.2. Below are two sets of data about recent Kentucky Derby
winners. For one set, a pie chart is the most effective presentation; for the
other set, a line graph best conveys the data’s meaning. Using a computer
program such as Word or Excel, create 1 line graph and 1 pie chart,
matching the data to its most effective graph or chart type:
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A. Where are the Kentucky Derby winners of the last 5 years?

e Kentucky Derby winners from 1999 to 2004 retired in
Kentucky as of 2004: Fusaichi Pegasus, Monarchos,
Smarty Jones (3 of 6 horses)

¢ Kentucky Derby winners from 1999 to 2004 retired in
Japan as of 2004: Charismatic, War Emblem (2 of 6
horses)

¢  Kentucky Derby winners from 1999 to 2004 that are still
racing as of 2004: Funny Cide (1 of 6 horses)

(Source: This information qualifies as common knowledge.)

B. The Kentucky Derby winners from 1999 to 2004 and their winning
race times (in minutes, seconds, and fractions of a second):

. 1999 - Charismatic - 2:03 1/4
e 2000 - Fusaichi Pegasus - 2:01
e 2001 - Monarchos - 1:59 4/5
e 2002 - War Emblem - 2:01

e 2003 - Funny Cide - 2:01 1/5
e 2004 - Smarty Jones - 2:04

(Source: “Kentucky Derby Winners,” accessed on August 25,
2004 at http://www.usatoday.com/sports/horses/triple/derby/
derby-winners.htm)

Exercise 3.3. Turn in drafts of your table, bar graph, line graph and pie
chart. From these, your instructor will choose several of each type and to
display for discussion. As you respond to each illustration, consider its
effectiveness for its purpose. What is it’s purpose? In what ways does it
succeed in fulfilling that purpose? Is there anything outstandingly suc-
cessful about it? Second, what suggestions can you offer your classmate
to make the illustration more effective? Questions to guide your evalua-
tions include:

e Is the type of graph or chart appropriate for the data it illus-
trates?

e Is the data complete, accurate (as far as you can tell), and placed
on the correct axis?

e Is the type clearly legible and not truncated or distorted?

*  Are all bars, slices and lines clearly distinguishable from each
other and from the background?

*  Are the label and source line correctly handled?

e Is the illustration’s appearance balanced, attractive and business-
like (is its tone appropriate for its purpose)?
e Is the text free of GSP bloopers?
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